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Computer Classes

ADVANCED INTERNET TIPS AND TRICKS

QUICK TIPS AND SHORTCUTS

QUICKLY GET TO DESKTOP: WINDOWS+D
Hold down the Windows key (between CTRL and ALT on the left side) and type D. All
windows will minimize so you can see your desktop. (Works anywhere)

SHIFT BETWEEN PROGRAMS: Alt+Tab
If you have multiple programs running at once, you can quickly flip back and forth to
them by holding down ALT and typing the TAB key. (Works anywhere)

PRINTING: If you want to print a page or some pages but not all, Select File> Print. (or
CTRL P) when the print window pops up, and you can choose which printer to use (at
the library it is blackwhite or color). Click on the button next to Pages and type which
pages you would like to print for example: 1, 3, 5-12. (Works anywhere)

PRINTING SOME OF A PAGE: Or, if you would only like to print a SELECTION of text:
Highlight the part of the web page that you would like printed. Select File> Print. (or
CTRL P) When the print box comes up, click the button next to Selection in the Page
Range. It will only print what you have highlighted. (Works Anywhere)

SEARCHING: CTRL+F (Also works in Word, Excel, etc).

If you are on a web page and are looking for a specific word, click Edit:>Find on this
page (or CTRL F). A window will pop up, and you type in the text you are looking for.
You can keep clicking next and it will show you each instance of that word.

@ In Firefox the box will appear at the bottom of the page.

TEXT LARGER OR SMALLER: CTRL++ or CTRL+- CTRL+0

On a web page (using IE or Firefox), holding down CTRL and typing + or — will change
the font size up or down. CTRL O returns it to normal. Also, hold down CTRL and scroll
the mouse wheel up or down. CTRL & + to make a page bigger CTRL & - to make it
smaller. (The mouse trick works in virtually all programs)

REFRESH WEB PAGE: CTRL+R or F5 key

If you feel that the page you are on is old, and that new information should be updated
already, use CTRL R to refresh the page. Anything new will be updated.

CHANGE YOUR HOME PAGE:
Internet Explorer: Tools>Internet options>General tab

Q‘ In Firefox: Tools> Options> Main tab
Type in your new home page in the box. (You can cut and paste as well)

TABS: CTRL+T

Both IE and Firefox use tabs. This allows you to keep multiple pages open at the same
time. In IE just click on the small box next to the name of the page you are on
(underneath the File, Edit etc menus)
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TABS

Open multiple websites in one Internet Explorer window with tabbed browsing. Rather
than having to open up multiple Internet Explorers or Firefoxes, the browsers now come
with Tabs. In both Firefox and IE you can get a new tab with this shortcut: Ctrl+T

In IE click on the empty tab to the right of the name of the page you are on.

If you click this tab, yyou can see thumbnail images of all open tabs in a sjgle view.
You can also click afgd drag your tabs to move them around.
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VIRUSES

You have probably heard about viruses. Viruses are programs that wicked people
create which, if you download, can more or less destroy your computer. People who write
viruses typically want to send a wake up message or show people that they are superior to
them.

Some phrases you may or may not have heard of: Computer viruses, worms,
Trojan Horses. They do something to your computer that you don't want them to do.
Some are very innocent and benign, simply displaying a message on your screen and then
going away. Others can be very destructive. They may delete chunks of important
information off your hard drive, grow on their own to the point that your hard drive fills
up, and even send email messages with your passwords, contact lists or any other
information to people far and near. Some viruses happen immediately; others lay in wait
for a specific day or trigger to do their dirty work. Still others have the ability to 'mutate,’
or change what they do and how they spread.

There are four primary ways that a virus will enter your computer: (1) through a
diskette, ZIP drives or other removable media; (2) as an email attachment; (3) as a file
you downloaded from the Internet; and (4) through file/folder sharing. (A fifth possible
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way is through a program or application that you purchased. The incidence of this
method of infection, however, pales in comparison to the other four. Most manufacturers
go to great lengths to ensure their distributed software is virus-free.)

WHAT TO DO?

As a general rule, you should never open a file or email attachment that you
weren't expecting - even if it's from someone you know.

This is where many people have gotten into trouble. Many current viruses spread through
email that looks like it's coming from people we know! Always be wary of unsolicited
email with strange or incomplete subject lines... and never open an attachment that you
are not anticipating. Virus programmers go to great lengths to bait their victims with
messages that seem to cry out: "open me, OPEN ME!"

1. Sound user practices
There are a few good habits that everyone can practice that will significantly mitigate the
possibility that a virus will affect our network.

« Never open a file or email attachment that you weren't expecting
o Be wary of all spam and unsolicited email
o Install a'good' antivirus program on your computer (see next item below)

2. AntiVirus Programs
There are numerous AntiVirus programs available for computers with varying levels of
completeness.

These are the most recognized AntiVirus programs, and they charge an annual fee.

The library uses Norton AntiVirus. (www.symantec.com)

Another reputable AntiVirus is McAfee (www.mcafee.com)

There is a third antivirus called AVG which is actually free. It is highly regarded and is
recommended by many reputable sources. (free.avg.com)

Things to look for in an antivirus program:

e Interval scanning: you can set a time interval for the program to thoroughly scan
your system.

e Automatic scanning: whenever you download a file from the Internet or copy
files from removable media (floppy disks, etc.) the information is scanned for
viruses.

e Automatic updates: This is a biggie. Many new viruses come out every week
and a program's detection capability is only as good as its virus definition (data)
files. Detection programs must have a description of the virus in their database,
otherwise the virus goes undetected. Many anti-virus software manufacturers
offer free periodic updates to their product's data files; some even do this
automatically via the web.
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Through a combination of awareness and current antivirus software, you should do well
in mitigating the risk of infection. HOWEVER: Nothing is 100% effective when it comes
to viruses. You should also practice good data habits: keep backup copies of your
important files in safe and separate locations.

ERRORS

Sometimes you will see this error message

= Internet Explorer, cannot display the webpage - Windows Internet Explorer
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Maost likely causes:
+ “ou are not connected to the Internet.
+ The website is encountering problems.
+ There might be a typing error in the address.

what you can try:

® Check your Internet connection. Try visiting another website to make sure you are
connected.

® Retype the address.

® o back to the previous page.

If this screen comes up, you have either typed the internet address wrong, they have
removed the page you are looking for or the website is having some kind of problem.
The easiest thing to do is to retype the address and see what happens. If you get the
same result there is probably something wrong with the web site. Or, your internet
connection could be down as well. Check your wires if no sites come up

The only thing worse than the above error is when you get something like this:

# northbrunswicklibrary.com - Windows Internet Explorer
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Online Library Resources
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If you type the address incorrectly, (often by typing COM instead of ORG (as above)),
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you may get a site that claims to be a real site, but actually isn’t. I'm not sure what this
site is, but it’s not going to help you. Even if you click on the links, it just keeps you on
their own site. It is some kind of search engine, and | don’t know enough about it except
to say, if you see something like this, go elsewhere!

SEARCHING THE WEB
LOCAL INFORMATION & RESEARCH

One of the first places to check when looking for local information or research is
the Library’s web page: http://www.northbrunswicklibrary.org

Click Community Resources on the tab on the left. You'll find state and local links, as
well as information on voting, passports, jobs, taxes, entertainment, and places of
worship.

Click Databases on the tab on the left. You'll find a list of subjects with comprehensive
databases geared towards those subjects.

USING THE WEB:

Typically you can find a business just by typing www.thecompanysname.com. This
doesn’t always work, but it's as easy as typing the company’s name into a search
engine.

Once you get to the company’s web page, if you want to find Phone Numbers or
other Contact information, it is usually under the About Us tab somewhere on the page.
Typically a company that is not customer friendly hides their contact info away, not on
the home page.

SOME NEWS SITES:
http://www.nytimes.com/
http://www.cnn.com/
http://www.foxnews.com
http://www.salon.com

SEARCH ENGINES:
The biggest search engine these days is Google. But there are others as well

www.google.com

www.yahoo.com

www.ask.com

www.dogpile.com

www.cranky.com (designed for folks over 50)
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Speaking of seniors, if you are a senior or looking for information for a senior, at
the end of this handout are some resources for seniors. If we have time we will
go over some in class. Most of the sites are set up so that you can browse them,
but if you want to take advantage of all of the features you will need to register or
become a member. Typically the memberships are free, and all they will ask for
is a ZIP code or something like it.

SEARCH ENGINES:
CHOOSE YOUR WORDS CAREFULLY

Use specific words to describe exactly what you're looking for. More general terms give
a larger number of results, so try to narrow your search. Example: Try "19th century
chairs" instead of "old furniture"; Use "digital camera reviews" instead of
"electronics"

Watch for words with more than one meaning. If you're looking for information on
modeling, make sure you specify "fashion” or "clay."

Wildcards A * is called a wildcard. For instance is you want information on any
Kennedy, you can type * Kennedy into Google, and it will give results of anyone with the
last name Kennedy. Not terribly useful here, but if you want to search for George Bush
father and son, you can type George * Bush to give results for George W. Bush and
George H.W. Bush (and anything else that may be between those two words

Search within a site: If you know the address that you want to search, you can put the
address in your search terms and it will search only that website

site:webaddress search terms example: site:nytimes.com elections

and your search results will all be from that page.

Search for a title of a page: intitle:avocado salad will find all pages with that phrase in
the title.

If you know that you are looking for a specific kind of file (a PowerPQOint presentation or
PDF file), use this phrase. filetype: doc (Word) xIs (Excel) pdf (Adobe Acrobat) swf
(Flash) and type in your search terms.

Most of these features are available on the Advanced Search link of the search engines.
You can get very very specific if you look at them.

Be Specific
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Before learning math, it's a helpful reminder that the more specific your search is, the
more likely you will find what you want. Don't be afraid to tell a search engine exactly
what you are looking for.

For example, if you want information about Windows 98 bugs, search for "Windows 98
bugs," not "Windows." Or even better, search for exactly what the problem is: "l can't
install a USB device in Windows 98," for example. You'll be surprised at how often this
works.

Using The - Symbol to Subtract

Sometimes, you want a search engine to find pages that have one word on them but not
another word. The - symbol lets you do this.

For example, perhaps you are looking for information specifically about Windows Vista
but keep getting pages about Windows 98 or Windows XP. You could eliminate them
with a search like this: windows -98 -XP

Perhaps you are a fan of the original Star Trek series but instead keep finding pages
about Voyager, Deep Space Nine or Star Trek: The Next Generation. Try a search like
this: star trek -voyager -deep -space -nine -next -generation

Combining Symbols

For example, remember the person who wanted pages only about Star Trek's original
series? We searched this way: star trek -voyager -deep -space -nine -next -generation

A better search might use subtraction and multiplication: "star trek" -voyager -"deep
space nine" -"next generation"

GOOGLE

13 Quick Tips To Search Google Like An Expert
Note: many of these tips work on all search engines, but if they don’t you’ll have
to go back to Google.

1. Explicit Phrase: Let’s say you are looking for content about internet marketing.
Instead of just typing internet marketing into the Google search box, you will
likely be better off searching explicitly for the phrase. To do this, simply enclose
the search phrase within double quotes. Example: “internet marketing”

2. Exclude Words: Let’s say you want to search for content about internet
marketing, but you want to exclude any results that contain the term advertising.
To do this, simply use the “-“ sign in front of the word you want to exclude.
Example Search: internet marketing -advertising

3. Site Specific Search: Often, you want to search a specific website for content

that matches a certain phrase. Even if the site doesn’t support a built-in search
feature, you can use Google to search the site for your term. Simply use the
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“site:somesite.com” modifier. Example: “internet marketing”
site:www.smallbusinesshub.com

4. Similar Words and Synonyms: Let’s say you are want to include a word in
your search, but want to include results that contain similar words or synonyms.

To do this, use the “~” in front of the word. Example: “internet marketing”
~professional

5. Specific Document Types: If you're looking to find results that are of a specific
type, you can use the modifier “filetype:” For example, you might want to find
only PowerPoint presentations related to internet marketing. Example: “internet
marketing” filetype:ppt

6. This OR That: By default, when you do a search, Google will include all the
terms specified in the search. If you are looking for any one of one or more
terms to match, then you can use the OR operator. (Note: The OR has to be
capitalized). Example: internet marketing OR advertising

7. Phone Listing: Let's say someone calls you on your mobile number and you
don’t know how it is. If all you have is a phone number, you can look it up on
Google using the phonebook feature. Example: phonebook:617-555-1212

8. Area Code Lookup: If all you need to do is to look-up the area code for a phone
number, just enter the 3-digit area code and Google will tell you where it’s from.
Example: 617

9. Numeric Ranges: This is a rarely used, but highly useful tip. Let’s say you want
to find results that contain any of a range of numbers. You can do this by using
the X..Y modifier (in case this is hard to read, what’s between the X and Y are
two periods. This type of search is useful for years (as shown below), prices or
anywhere where you want to provide a series of numbers.

Example: president 1940..1950

10. Stock (Ticker Symbol): Just enter a valid ticker symbol as your search term
and Google will give you the current financials and a quick thumb-nail chart for
the stock. Example: GOOG

11. Calculator: The next time you need to do a quick calculation, instead of bringing
up the Calculator applet, you can just type your expression in to Google.
Example: 48512 * 1.02

12. Word Definitions: If you need to quickly look up the definition of a word or
phrase, simply use the “define:” command. Example: define:plethora

Q Some benefits to Firefox
Security: Hackers are more likely to attack IE than Firefox, which appears to have a

tighter security protocol built in.
Built in SpellChecker: If you type words into a field, you can simply right click on the
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Word and it will offer you suggestions for alternatives.

Built in search: if you type in any search term into the address bar, Firefox will take you
to the first result on a Google search. (The same as clicking the I'm Feeling Lucky
button).

Shortcut Search: You can search for information directly on a web page shortcut.

Go to any webpage that has a search box (like the New York Times (nytimes.com))
Right click on the search box and click add a keyword for this search. A new window will
open. Type the name of the site you are at (New York Times) and add the shortcut
you'd like to use (nyt). Then the next time you want to find something on that website,
you can just type into the address bar: nyt search term and it will go right to the results
page of a search on that website.

Addons: a slew of things to help you customize your browser.
https://addons.mozilla.org/en-US/firefox/

Pop Up Prevention: Firefox automatically blocks pop ups unless you allow them to
come (some sites require them for new windows) To allow them: When a pop up is
blocked, a window shows you that along the top of you window. Click preferences and
you can choose from a menu of options like, allow pop ups from this site.

Blocking Ads: This is one of the addons mentioned above. It is installed on all of the
machines. If you compare a site with ads from IE to Firefox you will see that the ads are
not displayed. If you wish to download this yourself, Search online for Firefox Adblock
Plus and download it. Then subscribe (when the new window pops up) to EasyList
(USA).

Information for seniors

e Www.seniornet.org
SeniorNet's mission is to provide older adults education for and access to computer
technologies to enhance their lives and enable them to share their knowledge and
wisdom. SeniorNet is a nonprofit organization of computer-using adults, age 50 and
older.

e Www.senior.com
It has been along time coming but the new Senior.com website is being developed and
will be active in Fall of 2008. Our goal is to provide our website visitors and members
with a safe community to communicate with family and friends, to research information
and to purchase items in a secured environment.

e www.seniorspaces.blogspot.com
This is a blog created by Allan M. Kleinman, the Assistant Library Director Old Bridge
Public Library. It's very useful for local and library information for seniors.

e WWww.eons.com
Eons.com is the online community for “BOOMers,” those of us born between 1946 and
1964 and beyond, who want to learn and do more to make the most of every stage of
life. Our community is the place for you to explore your passions and interests, keep in
touch with friends and family, connect with interesting people to share life experiences,
and most of all—have fun!

e www.eldr.com
ELDR is a media company which seeks to inspire the influential 60-plus audience to
celebrate the joys, navigate the challenges and discover the meaning of aging. ELDR
brings an enlightened, entertaining and sometimes edgy approach to aging through its
reviews, articles and interviews, dynamic photography and artwork. Regular columns
include ELDR Travel, ELDR Yoga and ELDR Tech.

e Www.rezoom.com
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Welcome to ReZoom.com! We're redefining life for an ageless generation. Think of us as
your online gathering place. We're not focused on age - we're focused on living well,
being well, traveling well, investing well and helping build A Better World. If you're not
quite ready for that AARP card - then ReZoom.com is your place online. ReZoom.com is
also about entertainment and rediscovering the music that influenced generations. With
ReZoom Radio, you can listen to the music you grew up with and the music you've come
to love - free of charge.

e www.thirdage.com
ThirdAge Inc. is an online media and direct marketing company focused exclusively on
serving the needs of midlife adults -- generally those in their 40s, 50s and 60s -- and
those who want to build a genuine relationship with them. So this site is designed to
bring products to boomers. There are links for coupons and other things like it.

ONLINE COMMUNITY:: A resource where people who share similar interests sign up for
a website, and can then talk to each other, share pictures, recipes etc. They are an
excellent resource for people who can’t get around, or for people who are just looking for
new friends who share similar interests.
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